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Information contained in this manual is believed to be accurate and reliable. However, Evertz assumes no responsibility for the use thereof nor for 
the rights of third parties, which may be affected in any way by the use thereof.  Any representations in this document concerning performance of 
Evertz products are for informational use only and are not warranties of future performance, either expressed or implied. The only warranty 
offered by Evertz in relation to this product is the Evertz standard limited warranty, stated in the sales contract or order confirmation form. 
 
Although every attempt has been made to accurately describe the features, installation and operation of this product in this manual, no warranty 
is granted nor liability assumed in relation to any errors or omissions unless specifically undertaken in the Evertz sales contract or order 
confirmation.  Information contained in this manual is periodically updated and changes will be incorporated into subsequent editions. If you 
encounter an error, please notify Evertz Customer Service department. Evertz reserves the right, without notice or liability, to make changes in 
equipment design or specifications. 
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WARNING 

 

 

Never look directly into an optical fiber. Non-reversible damage to the eye can 
occur in a matter of milliseconds. 
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1. OVERVIEW 

The 7708VB-4-HSE is a VistaLINK® enabled transceiver for up to two HD-SDI signals or four SDI/DVB-
ASI signals, 10/100/1000 Ethernet or combinations thereof. The product acts as bi-directional Network 
Equipment, providing efficient use of 3 Gigabits of transport capacity in both directions. By combining 
multiple signal types and directions in a single compact product, the 7708VB-4-HSE provides savings in 
both rack space and wavelengths. 
 
All video signals may be asynchronous, and each output remains locked to its corresponding source. 
Video outputs are full-rate and uncompressed, with all horizontal and vertical ancillary data intact. 
Monitoring and control is provided locally at the card edge or remotely via VistaLINK®. 
 
Features: 
• Bi-directional transport of two HD-SDI, four SD/ASI or one HD-SDI plus three SD/ASI signals plus 

Ethernet on a single card 
• Ethernet transport connection may be RJ45 or optical when fitted with optional SFP optical modules 
• Flexible Bandwidth Management (FBM) to control Ethernet port data rate with respect to presence or 

absence of applied input video                      
• Signal transport uninterrupted by the application/loss of input signals 
• Pluggable SFP fiber module permits wavelength swapping/sparing 
• Comprehensive signal and card status monitoring via four-digit card-edge display 
• VistaLINK® enabled for remote monitoring/control using 7700FC VistaLINK® Frame Controller 

installed in 7800FR frame 
• Automatic coaxial equalization up to 100m at 1.485Gb/s (Belden 1694A or equivalent cable) and 

250m at 270Mb/s 
• Fully hot-swappable from front (main board) and rear (SFP fiber module) of frame 
• Optical output wavelengths of 1310nm, 1550nm, and up to sixteen CWDM wavelengths 
• Female LC Duplex fiber connector 
• Occupies two card slots and can be housed in the 3RU 7800FR frame which has a 15 slot capacity 

or the portable 3RU 350FR frame which has a 7 slot capacity or the 1RU 7801FR which has a two 
module capacity 
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Figure 1-1: 7708VB-4-HSE Block Diagram 
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2. INSTALLATION 

The 7708VB-4-HSE comes with a companion rear plate that has sixteen BNC connectors, two LC (one 
duplex) optical connectors and one RJ45 Ethernet connector.  The Ethernet interface may optionally be 
equipped with an SFP, in which case the Ethernet interface is on two LC (one duplex) optical connectors. 
For information on mounting the rear plate and inserting the module into the frame see section 3 of the 
7700FR chapter. 
 

 
Figure 2-1: 7708VB-4-HSE Rear Panel 

 
HD/SDI INPUTS:  Two auto-sensing BNC inputs for HD-SDI, SD/ASI. These inputs provide adaptive 

equalization for up to 100m of industry standard Belden 1694A cable at 1.485Gb/s, 
or 250m of 1694A cable at 270Mb/s.   

 
SDI INPUTS:   Two auto-sensing BNC inputs for SDI or DVB-ASI. These inputs provide adaptive 

equalization for up to 250m of industry standard Belden 1964A cable. 
 
HD/SDI OUTPUTS:  Two BNC outputs for HD-SDI, SDI/ASI.  
 
SDI OUTPUTS:   Two BNC outputs for SD/ASI.  
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FIBER IN/OUT:  Pluggable SFP fiber module with standard LC Duplex connector. The use of this 
pluggable optical module permits wavelength swapping/sparing.  SFPs must be 
Evertz SFPTR-xx series. When inserting an SFP, ensure that the main board 
remains properly seated by opening the frame door and applying pressure to the 
card-edge ejector. 

 
TRANSPORT 10/100/1000:  RJ-45 connection for transport of 10/100/1000 Ethernet. Flexible Bandwidth 

Management (FBM) is used to control Ethernet bandwidth allocation (see section 
4.2). 

 
TRANSPORT 10/100/1000 IN/OUT: Pluggable SFP fiber module with standard LC Duplex connector for 

transport of 10/100/1000 Ethernet. Flexible Bandwidth Management (FBM) is used 
to control Ethernet bandwidth allocation (see section 4.2). 

 

2.1. CARE AND HANDLING OF OPTICAL FIBER 

2.1.1. Safety 

 

CLASS 1 LASER PRODUCT 

 

2.1.2. Assembly 
Assembly or repair of the laser sub-module is done only at Evertz facility and performed only by qualified 
Evertz technical personnel. 
 

2.1.3. Labeling 
Certification and Identification labels are combined into one label. As there is not enough room on the 
product to place the label, it is reproduced here in the manuals. 

• There is no date of manufacture on this label as it can be traced by the bar code label placed on 
the printed circuit board of each Evertz plug-in module. 

 

 
Figure 2-2: Reproduction of Laser Certification and Identification Label 
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2.1.4. Handling and Connecting Fibers 

 

Always keep dust caps on optical fiber connectors when not connected and always 
remember to properly clean the optical end face of a connector before making a 
connection. Never touch the end face of an optical fiber.   

 
The transmission characteristics of the fiber are dependent on the shape of the optical core and therefore 
care must be taken to prevent fiber damage due to heavy objects or abrupt fiber bending. Evertz 
recommends that you maintain a minimum bending radius of 5 cm to avoid fiber-bending loss that will 
decrease the maximum attainable distance of the fiber cable. For further information about care and 
handling of fiber optic cable, see section 3 of the Fiber Optics System Design section of this manual 
binder. 
 

2.2. HARDWARE INSTALLATION 

Before handling the card it is important to minimize the potential effects of static electricity. It is therefore 
recommended that an ESD strap be worn.  Locate on a frame chassis 2 adjacent vacant slots. Unpack 
the 7708VB-4-HSE card and separate the rear panel from the main card. Locate on the rear of the rack 
the two slots and remove the blanking panels. Insert the rear panel into the back of the chassis and 
secure using the screws provided.  
 
Before inserting the front card, connect the serial cable to the board using the serial cable provided. Now 
insert the 7708VB-4-HSE card into the corresponding front slots ensuring the card lines up with the slot 
runners on the bottom and the top of the chassis. Push the card into the slot ensuring that when it mates 
with the rear card that is has been firmly pushed into a seated position. This can be confirmed when the 
connectivity lights for the Ethernet port are illuminated. Do not connect any cables to the rear card (failure 
to do this could cause unwanted network issues) until the initial configuration has been completed. 
 

2.3. CONNECTING TO VISTALINK PRO (VLPRO) 

This chapter assumes that the VLPro server and VLPro client are already configured for your network and 
you have basic knowledge of the VLPro interface. It also assumes that the user or network administrator 
has already added the 7708VB-4-HSE series jar file to the server and both the client and server 
applications have been restarted. If you are the network administrator refer to section 7.2 for information 
on updating the VLPro Server Jar File. 
 
Open VLPro and click on the refresh tree icon. Expand the hardware tree by clicking on the “+” symbol. 
Further expand the IP address of the FC of the frame in which the card is inserted. The 7708VB-4-HSE 
should appear as a newly listed device under the FC IP address. It may take up to a minute to appear 
while the card and switch negotiate network settings (this can be verified directly on the switch if 
necessary). 
 
Figure 2-3 identifies the parameters of the 7708VB-4-HSE module as it will appear if controlled via a 
Frame Controller:  
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Figure 2-3: VistaLINK® PRO Hardware Configuration 

 
Please consult your network administrator if you continue to have problems connecting the card with 
VLPro, alternatively contact Evertz Microsystems Ltd. or your authorized reseller for technical support. 
 



7700 MultiFrame Manual 
7708VB-4-HSE, Dual HD or Quad SD/ASI Transceiver with Ethernet 

 Revision 1.0 Page 7 

3. SPECIFICATIONS 

3.1. SERIAL VIDEO INPUT 

Number of Inputs:  4 
   Input 1-2:  SMPTE 259M-C, SMPTE 292M, DVB-ASI  
   Input 3-4: SMPTE 259M-C, DVB-ASI 
Connector:  1 BNC per IEC 61169-8 Annex A 
Equalization:  Automatic to 100m @ 1.485Gb/s and 250m @ 270Mb/s with Belden 1694A or 

equivalent cable 
Return Loss:  > 15dB up to 1.5Gb/s 
 

3.2. SERIAL VIDEO OUTPUT 

Number of Outputs:  4 
Standards:  
   Input 1-2:  SMPTE 259M-C, SMPTE 292M, DVB-ASI, SMPTE 305M (SDTi) 
   Input 3-4: SMPTE 259M-C, DVB-ASI 
Connector:  1 BNC per IEC 61169-8 Annex A 
Signal Level:  800mV nominal 
DC Offset: 0V ±0.5V 
Rise and Fall Time: 
   1.485Gb/s: <270ps 
   270Mb/s: 900ps nominal  
Overshoot:  <10% of amplitude 
Return Loss:  >12dB 
Alignment Jitter:  <0.2 UI 
 

3.3. OPTICAL LINK OUTPUT 

Number:  1 per SFP 
Connector:  Female LC Duplex 
Return Loss:  > 12dB 
Fiber Size:  9μm core/125mm overall 
Wavelengths: 
   Standard:  1310nm, 1550nm 
   CWDM: 1270nm – 1610nm 
Output Power: 
1310nm: -2dBm ±1dBm 
CWDM: +3.5dBm ±1dBm 
Rate: 3 Gb/S 
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3.4. OPTICAL LINK INPUT 

Number of Inputs:  1  
Connector:  Female LC Duplex 
Operating Wavelength:  1270nm - 1610nm 
 
Maximum Input Power: 
   Standard (+S) Receiver:  -1dBm 
Optical Sensitivity: 
   Standard +S) Receiver:  -21dBm 
Rate:    3 Gb/s 
 

3.5. ETHERNET INPUT/OUTPUT 

Standard:    IEEE 902.3 (10 Base T), IEEE 802.3u (100Base TX), IEEE 802.3ab   
                                              (1000base TX) 
Optical (when fitted with optional SFP) 
Connector:  SFP (Female LC Duplex) 
 
Output: 
Wavelengths: 
Standard  1310nm, 1550nm 
CWDM          1270nm – 1610nm 
Output Power: 
1310nm:          -2dBm ±1dBm 
CWDM:          +3dBm ±1dBm 
 
Input: 
Operating Wavelength: 1270nm- 1610nm 
Maximum Input Power: 
   Standard:  -1dBm 
Optical Sensitivity: 
   Standard:  -21dBm 
 
Electrical: 
Connector:   RJ45 
Cable Requirements: 
   10 Base T   UTP category 3, 4 or 5 cable up to 328ft/100m (2 pairs)   
   100 Base TX  UTP category 5 cable up to 328ft/100m (2 pairs) 
   1000 Base TX   UTP category 5 cable up to 164ft/50m (4 pairs) 
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3.6. ELECTRICAL 

Voltage:  +12V DC 
Power:  13W 
 

3.7. COMPLIANCE 

Electrical Safety:  Complies with CSA C22.2 No. 60065-03 IEC 60065-(2001-12) 7th Edition 
Complies with CE Low voltage directive 93/68/EEC 

Laser Safety: Complies with 24 CFR 1040.10 and 1040.11 except for deviations pursuant to 
LN No. 50, dated July 6, 2001 Complies with IEC 0825-1, Am. 2 

EMI/RFI:  Complies with FCC regulations for class A devices 
Complies with EU 

 

3.8. PHYSICAL 

Number of Slots:   2 
 



7700 MultiFrame Manual 
7708VB-4-HSE, Dual HD or Quad SD/ASI Transceiver with Ethernet 

Page 10 Revision 1.0   

4. STATUS INDICATORS AND DISPLAYS 

The 7708VB-4-HSE has 10 LED Status indicators and a 4 digit alphanumeric display on the front card 
edge to show operational status of the card at a glance.  The card edge toggle switch and pushbutton are 
used to select various displays on the alphanumeric display.  Figure 4-1 shows the locations of the 
indicators, toggle switch and pushbutton. 
 

FRAME STATUS 
ON/OFF

/ MODULE OK
LOCAL FAULT

SERIAL 
RUN/UPGRADE

SERIAL PORT

 PUSH BUTTON

MENU NAVIGATION 
TOGGLE SWITCH

In/Out 1

In/Out 2

In/Out 3

In/Out 4

LED 5
ETH

LED 6
Fiber Link

LED 7

SFP 8

LED 9

LED 10

 
Figure 4-1: Location of Status Indicators, Jumpers and Controls 

 

4.1. STATUS INDICATOR LEDS 

Two large LEDs at the front card-edge display the status of module as follows: 
 
MODULE OK: This Green LED indicates good module health. It will be ON while there is no laser, 

SFP, card-slot or power faults. 
 
LOCAL FAULT: This Red LED will illuminate when a fault condition is detected. Possible fault 

conditions include laser, SFP, card-slot or power faults. Whether or not this LOCAL 
FAULT indication is reported to the frame may be determined by the FRAME 
STATUS jumper (see section 5.1).   
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LEDs 1-4 have selectable video status indications as follows: 
 

4.1.1. Input Video Status 
Select indication of input video status using the CTRL/LED/VIN menu selection (see section 4.2). 
 

GREEN indicates the presence of a valid input to the corresponding channel. 
 

OFF indicates a signal loss of signal condition. 
 

 

4.1.2. Output Video Status 
Select indication of output video status using the CTRL/LED/VOUT menu selection (see section 4.2). 
 

GREEN indicates the presence of a valid output to the corresponding channel. 
 

OFF indicates a signal loss of the signal condition. 
 

4.2. DOT-MATRIX DISPLAY / CARD STATUS AND CONTROLS 

Additional status monitoring and controls are provided via the 4-digit dot-matrix display located at the 
card-edge. The card-edge toggle switch and pushbutton (see Figure 4-1) are used to navigate through the 
display menus.   
 
You can use the toggle switch to move up and down the list of available parameters to adjust.  To adjust 
any parameter, use the toggle switch to move up or down to the desired parameter and press the 
pushbutton.  Using the toggle switch, adjust the parameter to its desired value.  If the parameter is a 
numerical value, the number will increase if you push up on the toggle switch and decrease if you push 
down on the toggle switch.  If the parameter contains a list of choices, you can cycle through the list by 
pressing the toggle switch in either direction.  The parameter values are changed as you cycle through the 
list. 
 
When you have stopped at the desired value, depress the pushbutton.  This will return to the parameter 
select menu item you are setting (the display shows the parameter name you were setting).  To change 
another parameter, use the toggle switch to select other parameters.  If neither the toggle switch nor 
pushbutton is operated for several seconds the card edge control will exit the menu system and return to 
an idle state.  
 
On all menus, there is an extra selectable item: BACK. Selecting BACK will take you to the previous menu 
(the one that was used to get into the current menu).  On the main menu, BACK will both take the user to 
the normal operating mode (indicated by the moving line on the card edge display). 
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Level 1 Level 2 Level 3 Level 4 Level 5 Level 6 

OK                                 
LASR ERR               

          
CTRL INP CH1 

  TRAN 
EN 

  
  

DIS 
  BW 1 to 200Mbps(For 

ASI) 
CH2 
  

TRAN EN 
DIS 

  BW 1 to 200Mbps(For 
ASI) 

CH3 
  

TRAN EN 
DIS 

  BW 1 to 200Mbps(For 
ASI) 

CH4 
  

TRAN EN 
DIS 

  BW 1 to 200Mbps(For 
ASI) 

ETH 

INTF RJ45 

 

  
FIBR   

TRAN ENAB   
DISB   

BW Auto-0-1000 Mbps 
*Auto enables FBM 

  
  

OUTP CH1 TRAN EN 

  

DIS 
CH2 TRAN EN 

DIS 
CH3 TRAN EN 

DIS 
CH4 TRAN EN 

DIS 
 LED INP     

OUT     
STAT SFP POWR  

 

  
  
  OTW  

 
INP CH1 TYPE LOSS 

  

HD 
SD 
ASI 

STD Type according to 
STD code 
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CH2 TYPE LOSS 
HD 
SD 
ASI 

STD Type according to 
STD code 

Ch3 TYPE LOSS 
HD 
SD 
ASI 

STD Type according to 
STD code 

CH4 TYPE LOSS 
HD 
SD 
ASI 

STD Type according to 
STD code 

ETH  LINK UP 
DOWN 

SPD 10 
100 
1000 

OUTP CH1 MODE    

  

PYLD   
CH2 MODE    

PYLD   
CH3 MODE   

PYLD   
CH4 MODE    

PYLD   
    

   VER   
 

Table 4-1: Card Edge Menu Structure  
 
If a specific menu selection has a configuration value associated with it, then this may be changed using 
the toggle switch. Pressing the pushbutton will apply the displayed value and return you to the previous 
menu level.  
 
The most recent user selection will be maintained in non-volatile memory in the event of power 
loss to the module. 
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4.3. TOP LEVEL STATUS MENU STRUCTURE 

Table 4-2 gives a brief description of the top level of the STATUS menu tree that appears when you enter 
the Status card edge menu system.  Selecting one of these items will take you down into the next menu 
level to set the value of that parameter. The details of the each of the menu items are described in 
sections 4.4.1 to 4.3.6. 
 

SFP  Displays the SFP parameters 

INP  Displays the Video Input parameters 

OUTP  Displays the Video Output parameters 

ETH  Displays the Ethernet transport parameters 

VER  Displays the current firmware version 

Table 4-2: Top Level STAT Menu 
 

4.3.1. Displaying the Receiver Optical Power 
Menu selection can display the received optical power detected by the SFP module in (dBm).  To display 
the received power from the STAT menu, use the toggle switch and pushbutton to select the SFP menu 
item and then choose the POWR menu item. 
 
STAT  The following indications are possible: 

 
-30 to +8 Optical Power (dBm) 
LOW  Optical Power Low – Power is below –30dBm 
OVER  Optical Power Over – Power is over the specified maximum 

(damage may occur) 
NA  Not Available – Pluggable SFP module not detected 

SFP  
POWR   

-30 to + 8 dBm  
  

 

4.3.2. Displaying the Transmit Optical Wavelength 
Menu selection can display the nominal optical transmit wavelength.  To display the transmit wavelength 
from the STAT menu, use the toggle switch and pushbutton to select the SFP menu item and then choose 
the OTW menu item.  
 
STAT  The following indications are possible: 

 
0 to 3276.75  Nominal Optical Transmit Wavelength (nm) 
NA  Not Available – Pluggable SFP module not detected 

SFP  
OTW  

Values from SFP 
NA 
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4.3.3. Displaying the Input Video Standard 
Menu selection can display the status of the video signals present at its inputs.  To display the video input 
status from the STAT menu, use the toggle switch and pushbutton to select the INP menu item and then 
choose from CH1 to CH4. The following indications are possible: 
 

1080I-60 720P-60  
1080I-59.94 720P-59.94  
1080I-50 720P-50  
1035I-60 1080P-60  
1035I-59.94 ASI  
1080I-48 525I  
1080I-47.96 525I-SDTI  
1080I-60 625I  
 

STAT  TYPE Displays the type of the input signal from HD, SD or ASI 
 
STD Displays the standard of the input signal according to the 

STD code 

INP  
CH1-CH4  

TYPE STD  
LOSS 
HD 
SD  
ASI 

Acc to 
the 
STD 
code 

 
 

4.3.4. Displaying the Output Video Standard 
To display the video output standard from the STAT menu, use the toggle switch and pushbutton to select 
the OUTP menu item and then choose the desired video channel CH1 to CH4. The following indications 
are possible: 

 
1080I-60 1080I-48 720P-50 
1080I-59.94 1080I-47.96 ASI 
1080I-50 1080I-60 525I 
1035I-60 720P-60 525I-SDTI 
1035I-59.94 720P-59.94 625I 

 
STAT  MODE This menu selection displays the type of the output signal 

 
PYLD Displays Ok when a valid output is detected and LOSS 

when no output is present 
 
 

OUTP  
CH1-CH4  

MODE PYLD  

LOSS 
HD 
SD  
ASI 

Ok 
LOSS 

 



7700 MultiFrame Manual 
7708VB-4-HSE, Dual HD or Quad SD/ASI Transceiver with Ethernet 

Page 16 Revision 1.0   

4.3.5. Displaying the Ethernet Transmit Status 
To display the Ethernet status from the STAT menu, use the toggle switch and pushbutton to select the 
ETH menu item and then choose the LINK or SPD to monitor link status and the speed.  
 
STAT  LINK UP This menu selection displays the link status of the Ethernet 

 
SPD This menu item displays the speed of the Ethernet link  
 
 

ETH  
LINK SPD  

UP 
DOWN 

10 
100 
100 

 
 

4.3.6. Displaying the Firmware Version 
To display the module firmware version from the STAT menu, use the toggle switch and pushbutton to 
select the VER menu item.  The following indications are possible: 
 
STAT  The software version will be displayed here. For example:   

 
VER 1.0 BLD 067 

VER  
Software Version  

 

4.4. TOP LEVEL CONTROL MENU STRUCTURE 

Table 4-3 gives a brief description of the top level of the CONTROL menu tree that appears when you 
enter the Control card edge menu system.  Selecting one of these items will take you down into the next 
menu level to set the value of that parameter. The details of the each of the menu items are described in 
sections 4.4.1 to 4.4.6. 
 

INP  Configures the Video Input Control 

ETH  Configures the Ethernet Transport Control 

OUTP  Configures the Video Output Control 

LED  Configures the LED indications 

Table 4-3: Top Level CONTROL Menu 
 

4.4.1. Controlling the Input Video Enable/Disable and Bandwidth Allocation 
Input video transmission enable/disable and ASI bandwidth allocation can be adjusted with this menu 
control.  The ASI bandwidth allocation value represents the maximum allowable ASI payload bandwidth 
on the port in question, with the remainder of the bandwidth being made available for Ethernet transport.  
Signals with ASI payloads above this value will be disallowed.   To configure the ASI bandwidth allocation 
from the CTRL menu, use the toggle switch and pushbutton to select INP menu item.  The following 
selections are available for all four channels.  
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CTRL  TRANS Selects video input to be enabled or disabled  
BW Selects ASI video input bandwidth allocation ranging 

anywhere between 0-200Mbps 
INP  

CH1- CH4  
TRANS BW   

EN 
DIS 

0-200 
Mbps 

  

 

4.4.2. Controlling the Output Video Enable/Disable 
This menu item allows the user to enable or disable output transmission. To configure the video output 
from the CTRL menu, use the toggle switch and pushbutton to select OUTP menu item. The following 
selections are available for all four channels.  
 
CTRL  TRANS Selects video output to be enabled or disabled  

 OUTP  
CH1- CH4  
TRAN   

EN 
DIS 

  

 

4.4.3. Selecting the Ethernet Interface 
This menu item allows the user to select the Ethernet interface between RJ45 and Fiber. To configure the 
interface from the CTRL menu, use the toggle switch and pushbutton to select the ETH menu item. The 
following selections are available in the INTF menu item: 
 
CTRL  INTF Allows the user to select between RJ45 and Fiber interface 

for Ethernet. RJ45 is default selected. 
 

ETH  
INTF  

RJ45 
FIB 

  

 

4.4.4. Controlling Ethernet Transmission Enable/Disable 
This menu item allows the user to select the enable or disable the Ethernet Transmission. To configure 
the interface from the CTRL menu, use the toggle switch and pushbutton to select the ETH menu item. 
The following selections are available in the TRAN menu item: 
 
CTRL  TRANS Selects the Ethernet transmission to be enabled or disabled  

 ETH  
TRAN  

EN 
DIS 
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4.4.5. Controlling the Ethernet Bandwidth 
This menu item allows the user to select the Ethernet Transmission bandwidth allocation.  Setting a value 
here effectively gives Ethernet traffic priority over video and will allocate that amount of bandwidth for 
Ethernet transport, with the remainder available for ASI and video transport.  Any ASI or video signals 
whose bandwidth exceeds the available bandwidth not allocated to Ethernet will be disallowed.  In AUTO 
mode, video signals are given priority and the Flexible Bandwidth Management (FBM) automatically 
throttles the available Ethernet port bandwidth based on the amount of bandwidth not being utilized by 
applied video.  The 7708VB-4-HSE has a total transport bandwidth capacity of 3 Gb/s for all applied video, 
ASI and Ethernet signals. To configure the bandwidth from the CTRL menu, use the toggle switch and 
pushbutton to select the ETH menu item. The following selections are available in the BW menu item: 
 
CTRL  TRANS Selects the Ethernet transmission mode and Bandwidth 

AUTO       Enables the Flexible Bandwidth mode 
 

ETH  
BW  

AUTO 
0-1000Mbps 

  

 

4.4.6. Controlling the LED Status Indicators  
The LED status indicators can be controlled using menu selections. To configure the LED status 
indicators from the CTRL menu, use the toggle switch and pushbutton to select the LED menu item. The 
following selections are available: 
 
CTRL  INP Selects video input status for display according to section 

4.1. 
OUT Selects video output status for display according to section 

4.1. 

LED  
INP 
OUT 
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5. JUMPERS AND LOCAL CONTROLS 

Several jumpers, located at the front of the module are used to preset various operating modes.   
 

5.1. SELECTING WHETHER LOCAL FAULTS WILL BE MONITORED 
BY THE GLOBAL FRAME STATUS 

The FRAME STATUS jumper determines whether local faults (as shown by the Local Fault indicator) will 
be connected to the 7700FR frame’s global status bus. 
 
FRAME STATUS:  To monitor faults on the 7708VB-4-HSE with the frame status indicators on the Power 

Supply FRAME STATUS LEDs and on the frame’s Fault Tally output, install this jumper in the 
ON position (default). 

 
 When this jumper is installed in the OFF position, local faults on this module will not be 

monitored by the power supply LEDs or the frame’s Fault Tally output but will only be indicated 
by the local fault indicator on the card itself. 

 

5.2. CONFIGURING THE MODULE FOR FIRMWARE UPGRADES 

UPGRADE:  The UPGRADE jumper is used when firmware upgrades are being done to the card.  For 
normal operation, this jumper should be installed in the RUN position.  See the Upgrading 
Firmware section of this manual for more information. 

 
 To upgrade the 7708VB-4-HSE’s firmware, begin by pulling it out of the frame.  Move the 

UPGRADE jumper into the UPGRADE position.  Install the upgrade cable provided (located in 
the vinyl pouch in the front of this manual) onto the SERIAL header at the card edge (see 
Figure 4-1). Re-install the module into the frame. Run the upgrade as described in the 
Upgrading Firmware section of this manual.  Once the upgrade is complete, remove the 
module from the frame, move the UPGRADE jumper into the RUN position, remove the 
upgrade cable and re-install the module.  The module is now ready for normal operation. 
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6. VLPRO CONFIGURATION 

6.1. WHAT IS VISTALINK®? 

VistaLINK® is Evertz’ remote monitoring and configuration platform which operates over an Ethernet 
network using Simple Network Management Protocol (SNMP).  SNMP is a standard computer network 
protocol that enables different devices sharing the same network to communicate with each other.  
VistaLINK® provides centralized alarm management, which monitors, reports, and logs all incoming alarm 
events and dispatches alerts to all the VLPro Clients connected to the server.  Card configuration through 
VistaLINK® PRO can be performed on an individual or multi-card basis using simple copy and paste 
routines, which reduces the time to configure each module separately.  Finally, VistaLINK® enables the 
user to configure devices in the network from a central station and receive feedback that the configuration 
has been carried out. 
 
There are 3 components of SNMP: 
 
1. An SNMP manager, also known as a Network Management System (NMS), is a computer running 

special software that communicates with the devices in the network.  Evertz VL-Fiber demo Manager 
graphical user interface (GUI), third party or custom manager software may be used to monitor and 
control Evertz VistaLINK® enabled fiber optic products. 

 
2. Managed devices (such as 7708VB-4-HSE), each with a unique address (OID), communicate with the 

NMS through an SNMP Agent.  Evertz VistaLINK® enabled 7700 series modules reside in the 3RU 
7700FR-C MultiFrame and communicate with the manager via the 7700FC VistaLINK® frame 
controller module, which serves as the Agent. 

 
3. A virtual database, known as the Management Information Base (MIB), lists all the variables being 

monitored, which both the Manager and Agent understand. Please contact Evertz for further 
information about obtaining a copy of the MIB for interfacing to a third party Manager/NMS. 

 
For more information on connecting and configuring the VistaLINK® network, see the 7700FC Frame 
Controller chapter. 
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6.2. VIEW CONFIGURATION 

Right click on the 7708VB-4-HSE card in the side bar navigation tree and select the “View Configuration” 
menu item. The configuration page will open; it is from these configuration tabs that the 7708VB-4-HSE 
can be configured. Refer to the relevant section of this manual for an explanation of the features and 
functions. 
 

 
Figure 6-1: VistaLINK® PRO – View Configuration 

 

6.2.1. Video Control 
The Video Control Tab (Figure 6-2) allows the user to Enable and Disable the inputs and outputs of all 
four channels. It also allows the user to select the ASI Input Bandwidth cap. For more information refer to 
section 4.4.1. 
 

 
Figure 6-2: Video Control Tab 
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6.2.2. Misc Control  
The Misc Control Tab allows the user to configure Ethernet and optical settings. Figure 6-3 displays 
Misc Control Tab. For more information refer to section 4.4.5. 
 

 
Figure 6-3: Misc Control Tab 

 
Ethernet Interface Select:    Allows the user to select Ethernet interface between RJ45 or Optical SFP. 
 
Ethernet Enable:   Allows the user to Enable/Disable Ethernet. 
 
Ethernet Bandwidth:  When Ethernet Bandwidth Mode in User select, this control allows user to 

select Ethernet bandwidth. 
 
Ethernet Bandwidth Mode: Allows user to select between Flexible bandwidth Auto mode or User select 

force mode. 
 
Optical Power Threshold:   Allows the user to set the optical power threshold. 
 
Remote Reset:  Allows the user to perform a warm reboot. 
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6.2.3. Link Monitor 
The Link Monitor Tab (Figure 6-4) allows the user to monitor Link Frame and Payload status. It also 
performs link frame error count.  
 

 
Figure 6-4: Link Monitor Tab 

 

6.2.4. Video Monitor 
The Video Monitor Tab (Figure 6-5) allows the user to monitor Input Mode, Standard and Output Mode 
on all four channels. 
 

 
Figure 6-5: Video Monitor Tab 
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6.2.5. Misc Monitor 
The Misc Monitor Tab (Figure 6-6) allows the user to monitor various optical and Ethernet parameters. 
  

 
Figure 6-6: Misc Monitor Tab 

 

6.2.6. Notifications 
The Notification Tab (Figure 6-7) allows the user to enable or disable traps from being generated and 
remotely reported. It also monitors Link, Input, Output and Ethernet status. 
 

 
Figure 6-7: Notification Tab 
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7. TROUBLESHOOTING 

7.1. VLPRO DOES NOT DISPLAY THE 7708VB-4-HSE ALARMS 

The user must connect directly to the board via the serial port. Once a connection has been established, 
check and/or configure the SNMP settings with the correct VLPro Server IP address and ensure the 
community strings are correctly set. Refer to the network administrator if you are in doubt as to what these 
settings should be. 

 

7.2. UPDATING VLPRO SERVER JAR FILE  

Products from Evertz are constantly evolving and new features are often added. It is therefore important 
to update the JAR files in your system, to provide access to all the latest features or enhancements. It will 
also be necessary to add JAR files for new products. If your new product has not appeared, even after 
waiting a few minutes for the Ethernet switch negotiation to complete, then it is possible that your JAR file 
may be old or missing. 

 
To perform a JAR update, ensure that all VLPro clients are closed (those clients which are not closed will 
automatically be disconnected as soon as the VLPro Server is restarted). Maximize the VLPro Server 
window and from the Windows task bar; select Help> Apply Update> Product from the menu.  

 

 
Figure 7-1: VistaLINK® PRO Server  
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A window will appear, as shown in Figure 7-2, simply navigate to the location of the new JAR file and 
double click to select the file. The window will automatically close and the update will be applied in the 
background.  
 

 
Figure 7-2: VistaLINK® PRO – Applying JAR Updates 

 
You will be prompted to restart the server to enable the change to take effect. Apply as many JAR 
updates as required before restarting the server. 

 

 
Figure 7-3: “Please Restart Your Alarm Server” Dialog Box 

 

 
NOTE: You may confirm that all updates have been successfully applied by 
selecting from the menu Tools>View>Show/Hide Product update log. 

 
Shutdown the server by selecting from the menu: File>Shutdown Server. Now re-open the server, it is 
normal for the startup to take marginally longer while each individual update is being applied. Once 
complete, you may restart the VLPro Clients. As the Client restarts you will experience a short delay while 
the update is applied. A prompt will appear confirming that the updates have been applied. 
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